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1 Introduction 

1.1 System Description 
The DAQLink 4 system is a multiple channel 24-bit digital seismic acquisition system.  

Each DAQLink 4 unit can have 6 to 24 independent analog channels.  The DAQLink 4 system 
uses standard Ethernet network connections and standard TCP/IP network protocol.  Using its 
Ethernet hardware, multiple DAQLink 4 units can be connected together for increased number of 
channels.  Also, DAQLink 4s can be connected to any standard network configuration. 

 
The DAQLink 4 has provisions for the following options 

 Two – RS232 inputs and outputs 
 GPS receiver for position information 
 GPS receiver for timing reference, and adjustment of internal oscillator 
 Internal test oscillator 
 Two pre-amp gain settings 
 Compact Flash for storage of acquired data 
 Multiple DAQLink 4 units can be recorded simultaneously using standard wired 

or wireless network 
 Stand alone mode with GPS allows DAQLink 4 units to record autonomously 

without user intervention. 
 
 

The DAQLink 4 System consists of the following: 
 

 DAQLink 4 Unit – Digital to Analog converter unit with Ethernet interface.  DAQLink 
4-III is a 24 bit acquisition unit, with each box containing up to 24 channels.   The 
DAQLink 4 is also capable of outputting an analog signal using a 16 bit D/A converter. 

 Cables – Connection cables included are: 
o Power Cable (typically an Souriau 2-pin to SAE 2-pin DC plug) 
o Cat5 Ethernet Patch Cable to connect DAQLink 4 to computer 
o Analog Input connector – Custom cables are available upon request 
o 14 pin Aux connector 

 GPS – GARMIN GPS unit with an Souriau 4-pin connector 
 Battery – Depending on which options are required for the situation in the field, a battery 

and battery enclosure may be supplied by SSC. 
 Computer – The DAQLink 4 unit is typically connected to a notebook-type computer 

while in the field.  SSC currently supports computers running Windows 2000, Windows 
XP or Windows 7, and is equipped with a RJ45 gigabit Ethernet port.  

 Software – VScope software runs on the computer connected to the DAQLink 4.  Via the 
Ethernet, it communicates with the DAQLink 4 to configure and command it, and also 
receive the acquired data.  This software package allows viewing, analysis, and storage of 
the acquired data. 
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1.2 DAQLink 4 Software Installation and Setup 
Insert the VScope CD in your computer.  The CD will automatically install the VScope 

program and copy the DAQLink 4 manual.   
 VScope.exe – Program used to acquire analyze and store the analog data. 
 DAQLink 4 manual 
 
 

1.3 Ethernet Setup 
VScope is essential for setting up the DAQLink 4, and it communicates with the 

DAQLink 4 through the Ethernet.  This network must be setup on the computer before using the 
DAQLink 4 system. 

Please refer to Ethernet setup section of this manual for detailed instructions on setting up 
the Ethernet settings on your computer. 
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2 Cable Connections 

2.1 DAQLink 4 Unit Operation 
 
 

2.1.1 DAQLink 4 Unit 

 
 
 
 

2.1.2 DAQLink 4 Cable Connections 

 Connect the provided GPS dome to the 6-pin GPS connector 
 Connect the trigger cable (from the source unit) to the 3-pin connector 
 Connect the analog  line cable (aka the spread cable with attached geophones) 
 Connect the Cat5 patch cable(from your computer) to the 10 pin Ethernet connector 
 Connect the DAQLink 4 to your 12 VDC power supply with the provided 2-pin cable 
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DAQ4 

 
Distributed DAQ4 
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2.1.3 DAQLink 4 LED Operation 

 
 The Battery LED shows the current condition of the battery voltage.  This is usually a slow 

flash, roughly 0.2 seconds “on” and 0.8 seconds “off”. 
o Flashing Green – Battery voltage is above 12 volts 
o Flashing Amber – Battery voltage is between 10 and 12 volts 
o Flashing Red – Battery voltage is below 10 volts 

 
 If a network patch cable is connected, then the “Network Link” LED shows the status of the 

network: 
o Steady Green – Network present and connected 
o LED Off – No network found 

 
 If a network patch cable is connected, and the Network LED is flashing, then the “Network 

Data” LED shows activity on the network: 
o Flashing Green – Messages and data packages moving back and forth between a 

DAQLink 4 and a computer on the network 
o LED Off – No network activity 

 
 The “Status” LED warns of errors, confirms that the GPS unit has a satellite lock, and lets 

you know when DAQLink 4 is recording a shot record: 
o Fast Red Flashing – DAQLink 4 has detected a Compact Flash card error 
o Slow Red Flashing – DAQLink 4 has booted, but does not have GPS satellite 

lock 
o Green Flashing – DAQLink 4 is receiving valid PPS data from the GPS unit 
o Steady Red – DAQLink 4 received a trigger, and is recording a data file, but 

does not have a GPS satellite lock 
o Steady Green – DAQLink 4 received a trigger, is recording a data file, and has a 

GPS lock 
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2.2 Single Unit DAQLink 4 Configuration 
 

 
Figure 2.2 – The basic components for a DAQLink 4 System 

 
Shown in Figure 2.2 is the basic DAQLink 4 kit.  Besides the yellow DAQLink 4 unit 

and GPS unit, a computer, Ethernet cable, battery, spread cable plus a trigger cable, hammer 
switch and strike plate are shown. 

Not shown here are the geophone strings, and the sledgehammer! 
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2.3 Multiple DAQLink 4 Unit Operation 
 
Multiple DAQLink 4 units can be operated simultaneously.   A single DAQLink 4 will 

record up to acquire up to 24 channels and two DAQLink 4s will acquire 48 channels.   
Example: Ten DAQLink 4s can be configured to acquire 240 channels. 
 
The GPS receiver on each DAQLink 4 is normally used to synchronize the multiple units.  

(The wired trigger input can be used to synchronize the time breaks of multiple units if GPS 
signal is not available).  The GPS time of the trigger event can be sent via the Ethernet connection 
to all of the DAQLink 4 units, if one DAQLink 4 unit triggers, then all of the DAQLink 4 units 
will be commanded to trigger at the same time. 

 
With GPS timing synchronization, the DAQLink 4 units only require an Ethernet 

connection to acquire seismic data with multiple DAQLink 4 units.  Vscope software will 
synchronize the multiple units automatically. The Ethernet connection can be either a “Wired” 
network approach or the Ethernet connection can use “Wireless” Ethernet.  Also, a combination 
of Wired and Wireless connections can be used to connect the multiple DAQLink 4 units. 
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2.3.1 Networked DAQLink 4 Systems 
 
Each DAQLink 4 unit can be configured with 1 to 24 channels.  Different networking 

options are available depending on requirement and terrain using a combination of Wired or 
Wireless Networking. 

 
 
 

 

Networking Options Available for the DAQLink 4 include 
 Wired option 
 Ethernet 10/100 switches and cables (100 meter maximum length) 
 Ethernet Extenders – can operate up to 1 km on twisted pair 
 Wireless network –WiFi – Typical line of site operation or 100 meters between 

stations, 
 900 MHz WiFi – Typical 1 Km between stations  

 
Distributive DAQLink 4 – 

 Similar to DAQLink 4 unit 
 Includes Ethernet Extenders for wired Networking 
 Allows Wired or Wireless connections 
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2.3.1.1 Wired Network 

 

 
 

This picture shows a single DAQLINK 4 station setup in a wired telemetry mode. 
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2.3.1.2 Wired Network – 48-channel System using Ethernet Extenders 

Figure 2.4.2 shows an example of a 48 channel DAQLink 4 system using Ethernet 
Extender Units.  The twisted pair cable has a maximum length of 4 miles. 

 
Figure 2.4.2 48-Channel DAQLink 4 System 
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2.3.1.3 Wired Network – 48-channel System using Rugged Network Switches 

Figure 2.4.3 shows an example of a 48 channel DAQLink 4 system using 10/100 network 
switches.  The maximum distance between switches is 100 meters.  Power for the switches is sent 
down the cable from the units connected to the DAQLink 4 recorders. 

 

 
Figure 2.4.3 - 48-Channel DAQLink 4 System 
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2.3.2 Wireless Network 
DAQLink 4 units can be connected using Wireless network equipment. 

 

 
 
 

This picture shows a DAQLink 4 station and computer setup in a wireless network 
configuration.  Note the Wi-Fi transceiver. 
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2.3.2.1 Wireless Network Option 

 

 
 
This option is used to provide a wireless connection between DAQLink 4 units, or 

between the DAQLink 4 network and a field computer.  The wireless option kit includes one 
“Access Point” and one “Station”.   Typically two DAQLink 4 units and a computer can be 
connected with only one Wireless Network Option Kit.  The wireless option works well in “line 
of sight” operation, with distances up to 2 km.  However, in some areas where line of sight is 
limited, the wireless signal is also limited, and the range can be reduced to 50 meters or less.  
Multiple wireless network option kits can be used as repeaters to increase the range of the system. 

Each radio unit is powered by +12 volts through the POE connection in the Ethernet 
patch cable.  If the patch cable is connected to a DAQLink 4, then it uses power from the 
DAQLink 4’s battery.  If it is used as a repeater, then an adaptor connects the patch cable directly 
to a battery.  
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2.3.2..2 Wireless Repeater Station 

 

 
 
 

This picture shows a DAQLink 4 unit setup in wireless network mode.  This unit receives 
data packets with it’s “Wireless Access Point” and re-sends those packets, along with the data it 
has just recorded, using a “Wireless Station”.  This data is eventually received by the field 
computer for analysis, processing and storage. 
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2.3.2.3 Wireless Network – 48-channel System using Wireless Network 

Figure 2.5.2 shows is an example of a 48 channel DAQLink 4 system using the Wireless 
network option.  A second Wi-Fi transceiver pair could be employed to send data to the field 
computer. 

 
Figure 2.5.2 – 48-Channel DAQLink 4 System 
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2.3.2.4 Wireless Network – 72-channel System using Wireless Network 

Figure 2.5.3 shows is an example of a 72 channel DAQLink 4 system using several 
Wireless network options.  Another Wi-Fi transceiver pair could be employed to send data to the 
field computer. 

 
Figure 2.5.3 – 72-Channel DAQLink 4 System 
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2.3.2.4 Wireless Network – 96-channel System using Wireless/Wired 
Network 

Figure 2.5.3 shows is an example of a 96 channel DAQLink 4 system using two Wireless 
network options, and several wired Ethernet links.  Another Wi-Fi transceiver pair could be 
employed to send data to the field computer. 

 
Figure 2.5.3 – 96-Channel DAQLink 4 System 
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2.4 Distributed DAQLink-4 
Distributed DAQLink-4 has the same features as the DAQLink-4 unit. Plus the Distributed 
DAQLink-4 has a built in Ethernet Line Driver.  This allows a wired network connection over a 
twisted pair of wires up to 1KM in length between the two Distributed DAQLink-4 nodes. 

 
The Distributive DAQLink-4 unit has two connectors on the side 

 Local – connects to the Remote connector on the next Distributive DAQLink unit 
 Remote - connects to the Local connector on the next Distributive DAQLink unit  

 
Two wires are used for the Ethernet communication and two wires can be used to provide remote 
triggering to the next unit 
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Two Distributed DAQLink-4 
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Distributive DAQlink Version 1 and Version 2 
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Speed vs. Distance (25K-30Mhz Spectrum - Low Band) 
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The LEDs on the side of the Distributed DAQlink, show the Power, 
Lan1, Lan2 and Line status.   
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2.5Autonomous Operation 
Multiple DAQLink 4 units can be operated in a fully autonomous mode.  No Network 

cable or computer is required. 
Data is stored in each DAQLink 4 unit, to be downloaded after the survey is complete.  

The data is downloaded using the “Data Collector” software and then shot record files are created 
using the “Harvest” software. 

The GPS on each unit provides synchronization timing of the two units.  The picture 
below shows a 48 channel refraction system.  
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2.6 USB Operation 
Rugged USB sticks can be inserted in the 19 pin USB connector.  All of the data that is 

collected will be saved on the USB drive.  The USB drive should be formatted before inserting 
into the DAQLink unit.  The data on the USB drive will not be over written by the software, so 
make sure there is enough free space on the USB drive to save the required data. 

 
“Data Collector” software can be used to download the data from the USB sticks and 

convert the saved data to SEG-Y files. 
 
Also the “SrcSig” software can load the “dat” files on the USB sticks and display the 

data. 
 
The USB sticks are installed in 

rugged connectors.  The end of the rugged 
connector can be removed to insert or 
remove the USB sticks  
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2.7 Stackable DAQLink-4 
The DAQlink 4 can also be purchased in a Stackable enclosure. 
 
These units have all the interface connectors and status LED’s on the side of the box. 
 
This allows the units to be Stacked to acquire more than 24 channels at a single location. 
 
The latches on the side allow the units to be locked together. 

 
 
The latched unit shown is for a 48 Channel unit.  Additional modules can be added to increase the 
channel count. 
 
All the interface connectors are the same as used in the standard DAQlink 4. (Described in 
Section 2.1) 
 
The Ethernet (Data) ports are connected to the central computer with a simple Network Switch. 
 
A special GPS cable is available that will connect a single GPS unit to the multiple DAQlink 4 
units. 
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3 DAQLink 4 Quick Start Guide 

3.1 Set Fixed IP Address on Computer 
1. Set fixed IP address on your computer 
2. Follow instruction in Section 2 of the manual 
3. Fixed address of 10.0.0.101 should be used 

 

3.2 Install VScope software 
1. Insert CD to your hard drive. 
2. After Installation is complete then start the VScope program 

 

3.3 Connect Cables to DAQLink 4 
1. Connect Ethernet patch cable from DAQLink 4 unit to the Computer 
2. Connect GPS unit to 4-pin on DAQLink 4 
3. Connect Analog Geophone Cable to 55 pin connector 
4. Connect Trigger Cable to 3 pin connector 
5. Connect power (12 VDC) to 2 pin connector on DAQLink 4 unit 

 

3.4 Initialize DAQLink 4 unit 
1. Go to the Option pull down menu 
2. Select Device 
3. Highlight the DAQLink 4 unit # to be used 
4. Select DAQ settings – If DAQLink 4 does not respond check the Ethernet settings 
5. Set Channel #1 for desired settings 

a. Gain #16 works well for most seismic acquisition 
b. All other default selections should be OK 
c. Select Auto trigger 
d. Select the sample rate to use and the record length 

6. Select OK twice to load values into DAQLink 4 unit 
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4 Configuring the Software 

4.1 DAQLink 4 Setup 
Connect and power up DAQLink 4 unit.  Start the VScope program by double clicking on 

VScope.exe file in Windows Explorer.  Select the DAQ setup menu by selecting menu Options-
>Device.  Or “left click” the “Device” button on the toolbar. 

If no unit serial numbers are displayed in the window click Auto Detect.  All DAQLink 4 
units connected to computer should be automatically found and displayed. 

Make sure the unit is enabled.  A check mark by the serial number shows that the unit is 
enabled. Just left click the small box next to the serial number to enable it.  Multiple DAQLink 4 
units can be connected to one computer using standard network equipment (hubs, switches, 
wireless access points, etc).  

 

 
Figure 4.1 Device setup 

 
Figure 4.1 shows five DAQLink 4 units connected to the computer.  
The first column shows that DAQ1, DAQ2, and DAQ5 have been selected for 

acquisition. 
The user can change the second column, DAQLink 4 name field.   
The Serial # field is hardware programmed into the DAQLink 4 unit and cannot be 

changed. 
In figure 4.1, DAQ unit 5 is highlighted.  Clicking DAQ Settings or IP Settings will show 

the configuration of the highlighted unit.  To highlight a different unit simply left click on a 
different DAQ link name. 

Remove Button will remove the highlighted unit from the list. 
Add button can be used to add a new DAQLink 4 unit.  However, it is recommended to 

use the auto detect feature to add new units. 
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4.1.1 DAQLink 4 Order 

The order in which the DAQLink 4 units are shown is the same order that they will 
appear when the data is displayed.  The up and down arrows can be used to change the order of 
the DAQLink 4 units. 

4.1.2 Copy to All 

After setting up one DAQLink 4 unit, the DAQ settings can be copied to the other units.  
Highlight the DAQLink 4 unit that has been “setup”.  With multiple DAQLink 4’s connected the 
“copy to all” button will appear, press “yes” to copy the “setup” parameters to the other units, or 
“cancel” to bypass the copy to all function. 

4.1.3 IP Settings 

Each DAQLink 4 unit should have a unique IP address.  The IP settings selection allows 
viewing and editing of the current IP setting for the unit. 

For the IP address shown, the 192 defines a class C network.  With class C networks the 
first 3 octets must be the same for all units. This means that the first three entries (192.168.0) 
must be the same for the units to communicate.  The last octet is a number between 0-255.  The 
number 0 and the number 255 are reserved and should not be used for a DAQLink 4 IP address.  
Only the numbers 1-254 should be used.  The computer’s IP address should also be unique; it 
cannot have the same IP address as a DAQLink 4 unit. 

The Net Mask should be the same for all units.  All bits that are not 0 in the net mask 
have to match.  The “255.255.255.0” mask is shown which means the first 3 bytes (octet) have to 
match. 

Use DHCP server to configure IP address - When checked, the DHCP server does the 
IP configuration automatically.  The DHCP server supplies an IP address to any host that asks for 
it.  Recommend always using manual address when possible, because it's easier to troubleshoot in 
case of a problem. 

 
Figure 4.1.3 Device IP selections 
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4.2 DAQLink 4 Configuration Standard menus 
 
When first installed, the VScope program uses Standard menus.  These menus provide all 

of the necessary options for normal seismic operation.  The Advance menus are selected in the 
Option – Preferences – Menu. 

It is important on new installations to check the DAQ settings.  Click the “Device button” 
on the Tool bar and the DAQLink 4 Configuration Menu should appear.  This will also check that 
communication to the DAQLink 4 unit is working properly.  If the configuration window does 
not appear, it means that the DAQLink 4 unit selected is not responding.  This is usually caused 
by improper TCP/IP settings, or Ethernet cable not plugged in properly.  The computer or 
DAQLink 4 unit may need to be reset if the TCP/IP configuration has changed. 

An additional check of communication can be performed by first removing all DAQ units 
from the DAQ setup table.  Highlight the DAQ unit to be removed then press the Remove button.  
After all units have been removed, press the Auto Detect button and all units connected to the 
computer will be added. 
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4.2.1 Device Acquisition Menu – Standard Menu 

 

 
 

The Acquisition Menu allows the following selections 
 

1. Gain – This entry sets the pre-amp gain on the DAQLink 4.  Standard setting for 
seismic acquisition is “16”. 

a. Gain =1 maximum input is 6.6 volts peak to peak. 
b. Gain =4 maximum input is 1.65 volts peak to peak. 
c. Gain =16 maximum input is 0.432 volts peak to peak. 

 
2. Sample Rate – This entry allows for different sample rate selection.  A typical 

setting for oil exploration is “2 msec”. 
a. 16 msec – 62.5 samples per second 
b. 8 msec- 125 samples per second 
c. 4 msec – 250 samples per second 
d. 2 msec – 500 samples per second 
e. 1 msec – 1000 samples per second 
f. 0.5 msec- 2000 samples per second 
g. 0.25 msec- 4000 samples per second 
h. 0.125 msec – 8000 samples per second 
i. 0.0625 msec – 16000 samples per second 
j. 0.021 msec – 48000 samples per second 
k. 0.016 msec- 64000 samples per second 

3. Acquisition Time – This entry selects the acquisition time for each acquisition. 
4. Active Channels – Select number of active channels. 

5. Low Cut Filter – When checked will enable the 2Hz low cut filter in the 
DAQLink 4 unit.  



 

DAQLink 4 User Manual 

Seismic Source Company 38 

Trigger Settings allows for two different trigger inputs 
1. Auto Trigger (ReMi) – When this selection is enabled, the DAQLink 4 unit will 

trigger immediately and will record and transmit data to the VScope program 
without an external trigger. 

2. Trigger on Time Break (Hammer Switch) – When this selection is enabled, the 
DAQLink 4 unit waits for a switch closure on the trigger input connector.  This 
selection is used when trigger input is connected to a standard Hammer switch.  
Pins A and C of the 3-pin connector must be connected to the “+” side of the 
Hammer switch, and Pin B must be connected to the “–” side of the Hammer 
switch. 
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GPS Tab: 
 

 
 

The GPS menu is used to setup the DAQLink 4 for GPS position and timing. 
Normally an external GPS unit is used.  The baud rate selection is made with the Baud 

rate software switch.  
To use the standard Garmin GPS unit sold from Seismic Source, select External and 

19.2K baud rate. 
 
The GGA string should appear when the correct baud rate has been selected. 
 
Press the “Get Position” button to verify that the GPS unit has a valid position and the 

GPS PPS pulse is wired correctly to the DAQLink 4. 
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4.3 DAQLink 4 Configuration Advance Mode 
 
When first installed, the VScope program uses Standard menus.  These menus provide all 

of the necessary options for normal seismic operation.  The Advance menus can be selected in the 
Option – Preferences –Menu. 

Selecting Advanced Mode selects the advance menus: 
 

 
 

 
WinPcap network driver is required when using multiple DAQLink 4s with large 

channel count and fast sample rates. 
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4.3.1 Device Acquisition Menu – Advance Mode 

This menu allows the user to setup the acquisition parameters for the selected DAQLink 
4 unit.  Up to 24 channels per DAQLink 4 unit are shown.  The DAQLink 4 unit automatically 
checks the number of operating channels when the unit is reset. 

The channels must be enabled to acquire data.  A check mark shows that the channel is 
enabled. 

The end user can change the name field. 
The type field should be set to generic unless acquiring data from a servo hydraulic 

vibrator.  When performing quality control tests on a servo hydraulic vibrator it is very important 
to select the correct “type’ for each channel. 

Gain – 2 preamp gains can be selected (x1, x4, and  x16) 
Input – Should be set to Normal  

 Normal for Normal operation 
 Loopback is used for testing. 
 GND is used for testing.  Connects inputs to Ground for measuring 

instrument Noise Level. 
Units and Scale used to display the Y axis in different units than volts.  These settings 

allow the display to be modified for different units.  Normal entry is volts.  For velocity studies 
and strong motion, the display can be changed to show velocity or any other unit. 

Same Settings in all Channels – clicking this will copy all of the highlighted settings to 
all of the other channels 

Standalone button should be checked, when DAQLink 4 is acquiring data in standalone 
mode.  In this mode, the DAQLink 4 stores the data to the internal compact flash memory.  It 
does not require a computer to be connected to acquire data.  After the data is acquired, the 
DAQLink 4 is reconnected to a computer running the VScope program, and the data from the 
internal compact flash memory can be downloaded to the computer. 

 

 
Figure 4.3.1 Device Acquisition Menu 

 
Low Cut Filter – This selection enables the Low cut Filter in the DAQLink 4 unit.  . 
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4.3.2 Trigger Menu – Advance Mode 

The trigger menu is used for all acquisition.  The trigger can be set to one of the 
following selections 

 Auto Trigger – When auto trigger is selected the DAQLink 4 unit starts acquiring 
as soon as the start command is processed 

 Trigger on Time Break – When trigger on Time Break is selected, the DAQLink 
4 unit receives and processes the start command from the computer, it then waits 
for a signal on the Time break line before it starts to acquire data.  The time break 
circuit uses a differential input circuit.  At least 3 volts should be applied for 
reliable triggering.  The unit can either trigger on a low going high voltage or a 
high going low voltage.  Must enter trigger level – Typically 3.3 volts is used 
with a “hammer switch”.  

 Trigger on input channel – When trigger on input channel is selected, the 
DAQLink 4 unit receives and processes the start command from the computer, it 
then waits for the threshold voltage on the selected channel to be exceeded. 

 Trigger on “AUX Input” – The DAQLink 4 version 2 units have a second 
auxiliary input for triggering on an external geophone. The gain on the auxiliary 
input is set to x10, so a smaller signal can be used for triggering. Set the 
threshold value for desired trigger level.  Example if 0.01 volt triggering is 
desired for geophone triggering, then enter Threshold = 0.01 volts.  The auxiliary 
Geophone input is wired to the 14 pin MISC connector – pin F + and pin G - 

 Trigger on PPS Pulse – In this mode; the DAQLink 4 uses the GPS time to 
trigger the unit.  The Timer data determines when the DAQLink 4 will trigger. 

o Timer Start At time – enter time when first trigger should occur.  If set to 
00:00:00, the system waits for the next PPS pulse which satisfies the 
Repeat Every Entry 

o Repeat Every – Enter Time for unit to repeat trigger.  An entry of 
00:10:00 will cause the DAQLink 4 to trigger every 10 minutes.  Auto 
Start must be enabled for the unit to automatically repeat. 

 Pre Trigger Delay – The DAQLink 4 will record and display data before the 
trigger event.  Enter the time for the pre trigger acquisition 

 Synchronize A-D – not used with DAQLINK 4 units 
 Auto Start –When the auto start is enabled, the DAQLink 4 will automatically 

start a new record after it has finished with the previous recording.  This allows 
the DAQLink 4 to record continuous data, when auto trigger is also enabled. 

 Disabled – No internal Auto Start of DAQLink 4 is enabled – System must be 
restarted from VScope program 

 Without Start Command – With this enabled, the next time the DAQLink 4 is 
powered on, the unit will automatically wait for the trigger condition and start 
recording.  When reconnected to the computer, the “Stop” command must be sent 
to the DAQLink 4 to “Stop” recording before the computer will communicate 
with the unit correctly. 

 After Start Command – With this option enabled, the DAQLink 4 will not start at 
power on.  The DAQLink 4 waits for a Start command from the computer, then it 
will start and repeat if the trigger and repeat according to the” trigger” and 
“repeat every” settings. 

 Timer settings – Require one “Valid” GPS position to start operation.  After a 
valid position has occurred the internal clock on the DAQLink 4 unit is used.   
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Figure 4.2.2 Device Trigger 
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4.3.2.2 Trigger on Time Break Hardware 

The following schematic shows the “Trigger on Time Break” connections. 
 

 
 

The three pin trigger input is used when “Trigger on Time Break” is selected.  The 
positive side of the trigger input should be connected to pin “A” of the three pin connector and 
the negative side of the trigger input should be connected to pin “B”. 

 
When using a TTL level or a small signal source like a geophone only pin A and pin B 

should be connected to the DAQLink 4 trigger input. 
 
When using a “Switch Closure” hammer switch a pull up resistor is provided to complete 

the circuit.  The pull up resistor is available on pin “C” of the three pin trigger connector.  
Connect pins A and C to the positive side of the “hammer switch” and connect pin “B” to the 
negative side of the Hammer switch. 

 
The Trigger Level must be set for accurate triggering (Select voltage from 0.05 to 3.3 

volts).  For a typical hammer Switch using the +12 volt pull-up, the trigger signal starts at +12 
volts and goes to 0 volts when the Trigger occurs.  3.3 volts is typically used as a trigger 
threshold for the “Hammer Switch. 

 
For a Geophone input connect only pins A and B, the threshold voltage is normally very 

small when using a geophone for a trigger source.  See Aux Trigger input for triggering on 
Geophone. 

 
The edge of the trigger must also be selected.  For “Normal Hammer Switch” the signal 

should go from “High (+12volts)” to “Low (0 volts)”.  Select “Negative Edge” when using 
“Normal Hammer switch”. 

 
For Positive edge triggering, firmware version 5.62 is required to trigger on voltage 

smaller than 3.3 volts.  Previous versions of firmware always used 3.3 volts for trigger level when 
positive edge was selected. 
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4.3.2.3 Trigger on Aux Input Hardware 

The following schematic shows the “Trigger on Aux Input” connections. 

 
 
 
 

The 14 pin MISC input connector is used when “Trigger on AUX Input” is selected.  The 
positive side of the trigger input should be connected to pin “M” of the three pin connector and 
the negative side of the trigger input should be connected to pin “N”. 

 
The Trigger logic is very similar to the Trigger on Time Break selection.  However, the 

Trigger on AUX input has an additional Gain of 10 to improve triggering on small signal levels. 
 
The Trigger Level must be set for accurate triggering (Select voltage from 0.005 to 0.33 

volts).  For a geophone input connect only pins M and N.  Depending on sensitivity of geophone 
and the “Hit” level the desired trigger threshold must be set. 

 
The Threshold range is from 0.005 volts to 0.33 volts.  
 
The absolute value of the geophone will be used to trigger.  So if the trigger level is set to 

0.1 volts, the system will trigger when the geophone reaches either positive 0.1 volts or negative 
0.1 volts. 

 
For Positive edge triggering, firmware version 5.62 is required to trigger on voltage 

smaller than 0.33 volts.  Previous versions of firmware always used 0.33 volts for trigger level 
when positive edge was selected. 
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4.3.3 Order Menu – Advance Mode 

The order menu appears when a 24 channel DAQLink 4 is connected.  (NOTE: This 
menu is not active with 6, 12, or 18 Channel DAQLink 4 units).  The order menu is used to 
arrange the channel numbers in each DAQLink 4 unit.  This selection allows compensating for 
different spread cable configurations. 
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4.3.4 Device Analog Output – Advance Mode 

The DAQLink 4 uses the Analog Outputs to generate test signals.  For normal operation 
the output must be set to NONE. 

 

 
Figure 4.3.4 Device Analog Output 
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4.3.5 GPS – Advance Mode 

The GPS menu can be used to check the status of the GPS receiver.  Press the Get 
Position button and the screen will be updated with the latest serial message from the GPS 
receiver.  The GGA string will show the data from the receiver.  If valid GPS data is received, 
then the Latitude, Longitude, Altitude and time will be displayed. 

 
The GPS receiver can be connected internally to the unit or can be connected to the 

external connection.  Select the correct GPS configuration. 
 
The DAQLink 4 is designed to have an external GPS receiver connected to the 4 pin 

connector on the DAQLink 4 unit. 
 
The GPS receiver can be connected to the 4 pin GPS connector using the PT06A-08-4P.   
 
The normal Seismic Source GPS receiver is setup for 19,200 baud. 
 
To operate another brand of GPS receiver, the receiver must be setup with third party 

software for the following: 
 RS232 serial at 4800, 9600, or 19.2 K baud 
 $GPGGA and $GPRMC messages – do no enable any other message 
 PPS pulse – TTL level pulse per second 

 
Please check the Wiring Section of this manual for the connector type and pin connection 

information. 
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On the VScope software, go to options-Device -DAQ settings-GPS menu. 
 
Press "Get Position" will update serial string. 
 
The data in the top window will show the serial data from the GPS receiver.  Select the 

correct baud rate to view the serial data from the receiver. 
 
When the GPS acquires a lock and starts generating valid GPGGA message, then the 

GGA data string will update when the “Get Position” button is pressed. 
 
A valid PPS pulse is required for the DAQLink 4 to trigger on “PPS” or “Trigger on GPS 

time” to operate. 
 
If a valid PPS does not occur a “No PPS” message will appear in the GGA string 

window. 
 

 

 
Figure 4.3.5 Device GPS 
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4.3.6 DAQLink 4 Calibration – Advance Mode 

The DAQLink 4 preamplifiers can be set for different fixed gain settings.  In addition to 
this fixed gain setting, there is a software gain setting that is set by the user in the acquisition 
menu.   

To compensate for the different gains on the amplifier boards, a software calibration 
number is entered at the factory.  These entries are normal set once by the manufacturer.  If you 
need different gain settings, please consult the factory to adjust calibration numbers and amplifier 
gain settings.  

The Gains have been calibrated for both the High and Low Gain settings. 
 

  



 

DAQLink 4 User Manual 

Seismic Source Company 51 

4.3.7 Device Advanced Menu – Advance Mode 

The Reset DAQ button performs a reset on the DAQLink 4 hardware.  The DAQLink 4 
must have hardware version 3.03 date 12-2003 or newer and firmware version 4.9 or newer to 
perform the hardware reset.  

Reset Memory button is used to reset the storage of data to the internal Compact Flash 
Card.  The next acquisition after a reset will be stored in the first memory location on the compact 
flash card. 

Erase Memory button is used to FORMAT the CF Card.  This process should take only a 
few seconds.  The Status LED will FLASH RED while formatting.  If the Status LED continues 
to FLASH RED, then the CF Card must be replaced. 

Set Oscillator is used to set the internal oscillator on the DAQLink 4 unit.  Normally 
there is no reason for the end user to set the oscillator.  It is set to 2047 manual value at the 
factory.  If a GPS unit is connected, then the automatic correction option should be selected. 

GPS internal Clock connection - When using the GPS system for continues recording it is 
important to set the Oscillator to “Automatic Correction”.  This allows the precise PPS timing of 
the GPS unit to be used to adjust the internal clock on the DAQLink 4 unit. 

The Manual Value entry will show the current value being used by the DAQLink 4 unit.  
This is a digital number representing the adjustment required to the clock oscillator.  It is a value 
between 1 and 4095.  2048 is the center value for this number.  Typically the Manual value will 
show about 1800 when the clock is adjusted using the GPS time.  

 

 
Figure 4.3.7 Device Advanced Menu 
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5 Program Operation 

5.1 Acquisition 

Select menu Acquisition->Start or click  Acquire button or Press Ctrl A to start 
acquisition. 

Text at the bottom of the screen will display the status of the acquisition, next to the Rx 
and Tx lights. 

 Waiting – will be displayed when acquisition is started, but waiting for trigger 
 Acquired N sec – will be displayed after trigger has occurred and program started 

receiving data 
 Processing – will be displayed at the end of acquisition 
 Also the Status Tab at the bottom of the display can be used to monitor status of the 

DAQLink 4 units 
 

To stop acquisition in progress select menu Acquisition->Stop or click  Stop button 
or Press Ctrl T. 
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5.2 Projects 
VScope software uses projects to save program settings and to store acquired data.  The 

projects are like folders used to sort and store different data.  Each project saves its own 
configuration for acquisition parameters, plot selection, scaling options, and other VScope 
selections.  Plus each project has its own database where the program keeps the saved data.  This 
allows the user to have different settings for different jobs and quickly switch between them.  The 
program remembers last project and loads it automatically on startup. 

To create a new project click menu File->New Project.  VScope will reset all its settings 
to default values and will create an empty database.  The program will create a separate folder 
with the same name as a project and store new database and project file with extension *.vsp to 
that folder.   

To create a new project with the same settings as the current one select “Copy Settings 
From Current Project” enter a New Name for the New Project and press OK.   All settings from 
the current project will be copied to a new one.   

When VScope is started for the first time it creates a default project – Project1.  To 
change the current project use File->Load Project menu and select a VSP file to load. 
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5.3 Database 
5.3.1 Loading Data from Database 

The VScope program has a built in database support.  For this reason all of the data that 
acquired by the program is stored as records in a database rather than in separate files.  This 
allows for greater flexibility with data manipulation, record searching and analysis. 

 
Large number of Records in Database will slow program considerably.  Starting a 

new database will often to alleviate this problem.  Or do not save to database and only export data 
to SEG-Y or SEG-2 files. 

 
The user can see all of the records in the current project database and select any record 

for analysis by clicking  Open button or selecting menu File->Open (Ctrl O). 
 

 
Figure 6.3 Database Explorer 

 
All records in a Database window are arranged into a table. It shows the following 

columns: 
 Index – Number used to index the database. It is incremented every time a data 

record is stored. 
 Start ID – Identifies the Start ID of the record.  The start ID is incremented for each 

new start command. 
 Date – Date when data was stored to database. 
 Time – Time when data was stored to database. 
 Start Delay – Is used for continuous recording option.  A single start command and 

Start ID will initiate multiple records; the Start Delay is used to identify these 
multiple records.  It is the time from when the original start command is received to 
when the trigger occurred. 

 Comment – Comment for data record.  When recording and saving data to database 
automatically, comment from previous record is copied to current record. 
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Toolbar buttons at the top of Database window help to find particular record: 

 Import Records allows data to be imported into Database 

 Export Records allows selected records to Exported from the Database 

 Edit Comment (Ctrl E) – Use this button to view or edit the comment  

 Assign Source and Receiver Coordinates 

 Invert Selected Record – this will invert the data for the selected record.  Very useful 
for Shear Wave stacking 

 Delete (Del) – Use this button to delete data record from database 
 
 

Additional buttons: 
 

 Sort Records – Allows to select a column in the table, which will be used to sort records. 

 Search – Allows to search a record using Index, Date, Device or Record #. 

 Search in Comment – Helps the user to find a record, which has some word 
combination in the Comment column. 

 Range – Shows only records that lie withing some range (eg. betweet two dates). 

 Filter – Allows to set complex criteria for records to be shown in the table (Not 
implemented yet). 

 Show All Records – Cancels all ranges and filters and allows the user to see all records in 
the database. 
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5.3.2 DAQLink 4 and Channel Configuration 

Clicking the “DAQ Configuration” and the “Channel Configuration” buttons can show 
the DAQLink 4 Configuration and the Channel Configuration for the saved data.   The DAQLink 
4 Configuration shows the acquisition parameters for each DAQLink 4 used in the selected 
record, also the GPS data will be shown if available.  The Channel Configuration shows each 
channels setup for the DAQLink 4 unit selected in the DAQLink 4 Configuration. 

The DAQ Configuration includes the following information 
 Serial # – Each DAQ Link has a unique device serial number.  This number is stored 

to database to provide a unique identification for each record. 
 Record# – Each DAQ Link unit increments a counter every time it acquires data.  

This record number along with the device # provides a unique identification for each 
record. 

 Acquisition Time – Length of record in seconds. 
 GPS Data – Latitude, Longitude, Altitude and Time from the GPS receiver. 
 Valid GPS – Shows if a valid GPS position was used for this record. 
 X,Y, FileNum… – Shows data received from a Master Recording System.  This is 

used to associate files recorded with the DAQLink 4 units to the Master Recorder.  
When using the database and exporting SEG-Y files, the Index number of the 
database is used as File Number. 

 

 
Figure 5.3.2 DAQLink 4 and Channel Configuration 
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5.3.3 Import and Export Data 

The import and export functions located in File menu allow for data to be exported or 
imported to different projects or to different applications. The VScope currently offers the option 
for the following import and export files 

 VScope data files (*.vs2) – use this selection when moving data from one project to 
another, or from one computer running the VScope program to another. 

 Space delimited files (*.csv) – use this selection when importing or exporting file to 
third party software such as spreadsheet software (e.g. Microsoft Excel and so on). 

 Sercel VQC88 files (*.dat) – use this selection when importing or exporting data to 
be used on Sercel VQC88 analysis program. 

 Pelton Force Meter Files (*.fmr) – use this selection when importing or exporting 
data to be used with the Pelton Vibrator Quality Control System 

 SEG Y Tape format – (*.sgy) – use this to import or export data to the standard SEG-
Y Tape Format 

 SEG II format – (*.sg2) – use this to export data to the standard SEG-II Format 
 
 
While in the Database Explorer multiple records can be exported to SEG-Y, or SEG-2 

format.  First select the records to be exported by highlighting them using the left button and the 
“ctrl” left button.  After the desired records are selected use the pull down menu Record – Export 
(or use Export button on Toolbar) to select the export function. 

 
 

 

 
Figure 5.3.3 Exporting data with Database Explorer 
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While in the database explorer, all records can be selected by pressing ctrl A (or go to 
Edit- Select All Menu).  

 
After selecting all of the records, you can eliminate records that you do not want to 

export.  Move the mouse to the record that you would like to omit from the list.  Hold the ctrl 
button and press the left mouse button once.  Then go to the next record to omit and hold the ctrl 
key and press the left mouse button.  Continue until all of the records to be omitted have been 
selected. 

 
After selecting all the records, go to the Record – Export menu, or select Export button 

on Toolbar, to export the selected records. 
 
Pressing the left mouse button once will unselect the record from the list.  The record will 

show highlighted until another record has been selected. 
 
Doing a double click of the left mouse button will select the stack function. 
 
Holding the ctrl button and pressing left mouse once will unselect record, holding ctrl 

button and pressing left mouse button again will reselect the record.  
 
When storing multiple records to the VScope data files (*.vs2), all of the selected records 

will be stored to one *.vs2 file.  The multiple record *.vs2 file can only be loaded while in the 
database explorer menu.  Use the Records – Import menu (or use the Import button on the 
Toolbar) to load the *.vs2 file. 

 
When storing multiple records to SEG-Y or SEG-2 file format, each selected record will 

be saved to a different file name. The name that is entered in the “save as” window will be used 
along with the record number to create the file name.  
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5.3.4 Storing Data to Database 

After acquisition is finished you can save new data to database.  Select menu File->Save 
(Ctrl S).  A window will appear where you can enter a comment for current record.  By default 
this window displays a comment from the last record in the database.  

 

5.3.5 Stacking Data in Database 

While in the Database menu, multiple records can be stacked together.  Select the records 
to be stacked by pressing the “Ctrl” key and clicking the left mouse button.  After the records to 
be stacked have been selected, press the “Load Stacked” button in the bottom right hand corner of 
the screen.  The selected records will be added together and can now be viewed.  Press the File – 
Save button to save the stacked data to the database.   

 

 
Figure 5.3.5 Stacking data with Database Explorer 
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5.3.6 Inverting Data before Stack – Shear Wave 

One method of Shear Wave acquisition is done by hitting one side of a plate and storing 
the data, then hitting the opposite side of the plate and storing the data.  The second record is 
inverted and then the two records are summed to show only the Shear wave energy. 

 
VScope allows this operation.  Store both of the records to the database.  Then go to the 

database and select the second record.  Press “Ctrl I” to invert all of the traces in the selected 
record. 

 

 
 

After the traces have been inverted, the values in the Calibration column will show 
negative numbers. 
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After the one record has been inverted, then select the two records to stack, then press 
“Load Stack” button to view the two stacked traces 

 

 
 

The stacked data can then be stored to the database. 
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5.3.6.1 Real Time Inversion of Data 

 

  The data can also be inverted during acquisition with Positive/Negative button 
in the Toolbar. 

The polarity of all of the data is inverted when  is shown.   
 
This extra Toolbar button is enabled in the Options – Preference – Stack Menu. 
 
The Stack Menu’s Enable Polarity Selection for Stacking will enable and extra button in 
the VScope Toolbar which will invert all of the data. 
 
Ctrl +P will toggle from Positive to Negative. 
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5.3.7 Near Trace Gather 

While in the Database menu, select the records to use for the Near Trace Gather by 
highlighting each record. 

 

 
 

After highlighting the desired records, select the “Near Trace Gather” option in the File 
menu. 

Enter the channel # for the near trace gather.  This one channel from each record will be 
plotted 
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5.4 Data View and Analysis 
 

5.4.1 Graph plot types 

Buttons on the toolbar and the View menu allow you to select different ways of signal 
representation on the graph plot 

 

  Shows time domain plot of acquired signal. 
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 Shows signal spectrum in frequency domain 
 
The time window allows performing a spectrum analysis on a time window.  An entry of 

1 to 2 performs the spectrum on the data between 1 and 2 seconds.  An entry of –1 to –1 performs 
analysis on the whole trace. 
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 Select correlation to display correlation, phase of 
correlation, envelope of correlation, or spectrum of 
correlation.  Also, correlated Seismic Plots can be displayed. 

 
The correlation will be performed using the channel defined in the DAQ units type field 

= Reference.  Other channels can be selected with the assigned reference pull down menu. 
 
Seismic Plot can be shown in Vertical or Horizontal display.  Also peaks of signals can 

be clipped. 
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5.4.2 Plot Popup Menu 

The same selections are available in the plot popup menu. On any plot press the right 
mouse button to bring up the plot menu. 

 

 
Figure 5.4.2 Plot Popup Menu 

 
Axis allows changing of the x and y axis of the plot. 
 
Selecting “Full View” or pressing “ctrl +F” zooms out completely to show the entire plot. 
 
Show Legend –enables and disables the text legend at the bottom of the plot. 
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5.4.3 Store Plot Menu 

Store Plot – allows the current plot to be saved to memory and viewed later as an overlay 
to another signal. The first trace in a plot will be stored.  The color and name of each stored plot 
can be changed in the Store Plot Menu.  The stored plot data can be saved and later loaded from 
disk with the Save and Load buttons in the Save Plot menu.  The store plot menu is used to 
compare data using the same sample rate.  Data acquired using different sample rates will not be 
displayed correctly.  

 

 
Figure 5.4.3 Store Plot Menu 

 
 
View Stored – used to retrieve the saved plots in memory. 
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5.4.3.1 Store All Plot Menu 

Store All Plots – allows the current plot to be saved to memory and viewed later as an 
overlay to another signal. 

 
 
All channels can be stored using the “Store All Plots” Function. 
 
Right click the Plot to bring up the “Store All Plot” Option 

 

 
 
 

After storing all plots, a second group of plots will be displayed.  This allows for quick 
comparison of traces from different records. 
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5.4.4 Seismic Plots  

There is an additional option for a Seismic Plot.  When the signal traces plot is selected, 
the Seismic Plot option can be selected. The traces in this plot can be either horizontally or 
vertically displayed.  Also, the peak of the signals can be clipped to allow better viewing of 
multiple channels with large gains. 

 

 
 

Figure 5.4.4 Vertical Seismic Plot – The x-axis shows “Trace #” 
 
 
The Seismic Plots use special keys to control the gain and traces separation.  The normal 

Zoom and axis control used in the other plots do not work well with the Seismic plot 
 
The “+” key on the numeric keypad – increases gain of each trace 
The “-” key on the numeric keypad – decreases gain for each trace 
The “Ins” (Insert) key increases separation between traces 
The “Del” (Delete) key decreases separation between traces 
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Pressing the right mouse button, when the pointer is on the graph, will open the plot 
popup menu.  Select the Scale feature.  The scale window allows the user to select different 
scaling options for the Seismic Plot.   

Absolute Max – Applies the same gain to every trace 
Equalize – Applies a different fixed gain to each trace.  The gain is different for each 

trace to equalize the amplitude of the traces.  
AGC – Applies an AGC (automatic gain control) to the data.  The AGC algorithm 

equalizes the energy in the entered time window. 
Individual Scale – The user can enter a fixed scale for each trace.  Highlight the channels 

under the individual scale selection, and use the up down arrows to increase or decrease the scale. 
Clip Channels – When selected the amplitude of each channel will be clipped, so that it 

will not overlap to the next channel. 
 

 
Figure 5.4.4.1 Vertical Seismic Plot – Scale Feature 
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5.4.5 Setting Zoom Level 

Zoom buttons on the toolbar and the View menu help to adjust a view of a selected plot 
 

  
Axis allows changing of the x and y axis of the plot. 
 
Selecting “Full View” or pressing “ctrl +F” displays the entire plot. 
 
To adjust zoom with the mouse press the left mouse button and make a box to zoom in on 

an area of the plot. Start at the top left corner and move to the bottom right corner. 
 

 
Figure 5.4.5 Zooming In with the Mouse 

 
After releasing mouse button the plot will zoom in. After zooming in, making a box with 

the mouse from bottom right to top left will zoom out. 
 
The plot position can be changed by clicking and holding right mouse button and 

dragging plot in desired direction. 
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5.4.6 Additional Plot Functions 

 

 Opens a new plot window 
 
 

 This option toggles the remove DC feature.  When enabled 
this feature removes the DC component from the input signal 
before plotting or analyzing data.  Status of selection is 
shown in the Plot info window at the bottom of the screen. 

 
  



 

DAQLink 4 User Manual 

Seismic Source Company 75 

5.4.7 Filters 

 High Cut, Low Cut and Notch filters can be setup and selected.  The Tool 
bar can be used to select or unselect each filter.  If the Toolbar button appears pressed in then the 
filter is selected. 

 
The setup for each filter can be found under the pull down menu Option – Preference.  

The pass band, and stop band frequencies for the Highpass and Lowpass filters can be set.  The 
Notch Filters Center Frequency and the width can also be set. 

 

 
Figure 5.4.7 Filter Selection 

 
There are two additional options for exporting the data.   
 
Normally the remove DC offset when exporting is always enabled 
 
The “Export filtered data if filter is enabled” selection is normally not enabled.  When 

enabled the exported SEG-Y or SEG-2 data will have the filters applied.  Normally the raw data 
is exported and filtering is done by the processing center. 
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5.4.8 General Settings 

 
The General Settings menu allows the user to select either the A/D units (Volts), or some 

other display unit which was setup in the DAQLink 4 configuration. 
 
For normal Seismic operation A/D units should be used 
 
Show Caption Buttons – allows the Toolbar Menu to be easier to use. 
 
WinPcap network drive – this network driver allows the program to receive data much 

faster over the Ethernet connection.  This driver is required when doing multiple boxes at high 
sample rate 

 

 
Figure 5.4.8 Display Settings 
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5.4.9 Auto Save and Auto Start 

Auto Start Acquisition can be enabled from the main menu with the Repeat 
Button. After the data is acquired from all of the selected DAQLink 4 units, the VScope program 
automatically sends a new start command out to the selected units. 

 
Auto Save menu allows the user to setup the following automatic save operations.  
 

 Auto Save Single Records to Database – After the data is acquired from all of the 
selected DAQLink 4 units, the data is automatically saved to the database with 
the comment that is in memory.   

 Auto Export Single Records to File - Allows all data to be exported to SEG-Y or 
SEG-2 files.  Export Type and Export Path determine what type of file is 
exported and where the data will be stored. 

 Confirm Before saving to Database.  Select this option if to view data before 
saving or exporting  

 

 
Figure 5.4.9 Auto Save 
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5.4.10 File Export Options 

File Export Menu allows the user to setup the following file export selections  
 

 Short File Names – When selected the program uses the File Number and the 
extension 

 Detailed File names – When selected the program uses the File number plus the 
date plus the time delay and the extension. 

 File number Length – The File number length can be limited by this entry.  
Example a 4 digit limit, will limit the file number from a value of 0000 to 9999. 

 Append CSV Files is used when exporting CSV type files.  When selected the 
new CSV data is appended to the old data.  When not selected a new CSV file is 
created for every record 

 
 

 
Figure 5.4.10 File Export 
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5.4.11 Stack Menu 

Stack menu allows the user to setup the following automatic save operations.  
 

 Auto Stack Records- When selected the program will automatically stack the 
records. See Memory Function 

 Save Stack to Database – When selected the stacked data will be saved to 
database 

 Export Stack to File – When Selected the stacked data will be exported to a file 
 Confirm before stacking – When selected the operator must select to add record 

to stack 
 Confirm before saving stack – When selected the operator must confirm before 

the stack is saved to the record 
 Enable Polarity Selection for Stacking will enable and extra button in the VScope 

Toolbar which will invert all of the data.    Ctrl +P will toggle from Positive to 
Negative 

 
Use Save (Ctrl +S) to save stack at anytime 
Use Clear (Ctrl+L) to clear stack 
Press F2 to save and start new stack at anytime 
 
 

 
Figure 5.4.11 Stack Menu 
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5.4.12 Lock and Unlock Menu Option 

 
The Lock menu option is normally not used.  It is designed to lock the menu when 

operating in an automatic acquisition mode, therefore ignoring any accidental keyboard entries. 
 

 
 

 
To remove the keyboard lock, type “ssc”. 
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5.4.13 Noise Statistic Window 

 
The real time Noise Monitor Window can be selected by the “Open Noise Statistic” 

button on the tool bar, or by pressing ctrl F7. 
 

 
 

 
The Noise Statistic Window shows analysis of the current acquired data. 

 

 
 
 
The RMS, maximum, minimum, and DC levels of each trace are shown for the current 

record.   
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5.4.14 Real Time Noise Monitor 

 
“N” key is used to enable and disable the Real Time Noise Monitor.  
 
The Real Time Noise monitor provides a continuous monitor of the line noise.  This 

graph is very useful in determine line noise between shots. 
 
The Y-axis needs to be selected to a fixed scale.  This allows the bar graphs to show the 

noise levels related to a fixed scale.  If auto scale is selected, then the bar graphs show full scale 
even when the noise level is very small. 

 

 
 

 
Default scaling of the x and y axis is autoscale. 
 
The scale should be changed to a fixed scale by right clicking the graph and selecting the 

Axis menu. 
 
Select the fixed y-scale so that the bar graphs are small for acceptable noise levels and the 

bar graphs are large for high noise levels.  This allows the operator to monitor the noise level on 
the spread in real time.  On some jobs with large cultural noise, the real time monitor is used to 
time the trigger event for minimal noise levels. 

 
Press “N” to disable the Real Time Monitor 
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5.5 Status Information Tabs 
The Status information tabs at the bottom of the main window provide useful information 

about the current operation of the system. 
 

5.5.1 Comment  

 
The Comment tab shows the current comment for the record 
 

 
 

Figure 6.5.1 Comment 
 

5.5.2 Record Information 

 
The Sweep information tab shows important information about the record. 
 

 
 

Figure 5.5.2 Record Information 
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5.5.3 Plot Information 

The plot information tab shows the status of the plot selections for the current record. 
 

 
 

Figure 5.5.3 Plot Information 
 
 

5.5.4 Status 

The Status tab shows the status of the DAQLink 4s connected to the system.  This is very 
useful in troubleshooting wireless Ethernet connections. 

 

 
 

Figure 5.5.4 Status 
 
 

5.5.5 Errors 

The Error tab shows any communications error or error detected by the DAQLink 4 unit.  
If an error occurs this tab is automatically displayed. 
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5.5.6 Communication Tab 

The communication tab shows the current status of the DAQLink 4 units that have been 
selected in the DAQLink 4 setup menu.  This is useful when using the wireless Ethernet option.  

 

 
 

Figure 5.5.6 Communication 
 
 

5.5.7 Network Tab 

The Network Tab is used to show the current IP address that was detected when VScope 
started.  The IP address of the computer should show 192.168.0.101. 

  

 
 

Figure 5.5.7 Network Tab 
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5.6 Memory Window – Stacking Operation 
The memory window is used to stack multiple records in real time.  Go to the Option – 

Memory selection to open the memory window.  The Option – Preferences – Auto operation 
settings are also used to set up automatic stacking and storing of multiple records.  Each record is 
stored in memory and can be saved to the database. 

 

5.6.1 Auto Stack Operation 

 
The “Auto Stave, File Export and Stack” menu can be used to automate the stacking 

and saving process.  See section 5.4.9 through 5.4.11 
 
 
When Auto Stack is enabled the following “Hot Keys” can be used 
 
“ESC” Stops Acquisition 
“Clear” button on Tool Bar will reset Stack number to “1” 
“F2” Ends Stack – Saves current Stack and Clears Stack number 
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5.6.2 Memory Window 

 
Opening the Memory Window shows details of the stacking process 
 

 
 

Figure 5.6.2.1 Memory Window 
 
The memory window tool bar is used to control the operations of the memory window. 
 

 The memory clear button is used to clear all records from memory.  Press this button 
before starting a new stack 

 The load from database button allows a record from memory to be loaded into the 
memory buffer 

 The save to database button saves all of the selected records in the memory buffer to 
the database 

 The stack button allows the selected records in memory to be stacked 

 The memory delete button allows the selected record in the memory buffer to be 
deleted. 

 The show record button allows the selected record in the memory buffer to be 
viewed. 

 

 
 

Figure 5.6.2.2 Memory Window Tool Bar 
 

  



 

DAQLink 4 User Manual 

Seismic Source Company 88 

5.7 First Break Pick Feature 

The Edit -Picker menu or the  button on the tool bar is used to enable the first break 
pick feature.  With this feature enabled go to the point on the screen and left click the mouse. 

 

 
 

Figure 5.7.1 Picks on Seismic Plots 
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Right click on the screen and select pick table.  The pick table will appear on the left side 
of the seismic plot.  The time of each pick is shown in the table. 

The geophone spacing is entered at the bottom of the screen.  The velocity will be 
computed using the picks and the geophone spacing.   
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The Edit – Geometry selection or the  on the toolbar is used to select the geometry 
window. 

The X (distance) and Z (elevation) of each geophone is entered in the table. 
 

 
Figure 5.7.2 Edit Geometry Screen 

 
 
The File –Save pick selection is used to save the picks to a File.  This pick file is in a 

standard format to be used by other processing software. 
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5.8 Refraction Example Setup 
 
The VScope software with the DAQLink 4 unit has been designed to be a very flexible 

system which has many options for setup.   
 
Once System is setup, all settings are stored in the “Project Settings”.  When a new 

project is created, the current project settings can be copied to the new project.  All settings are 
copied, so the setup of all of the options and displays is only required once. 

 
Typically system setups should be saved to “standard projects” which can be reloaded 

into VScope program.  This allows different setups to be saved to the computer for different 
applications.  Then when in the field, the standard setup can be loaded into the computer and 
everything is ready to go 

 
 
The following example shows a typical setup for a refraction survey using a Sledge 

Hammer as a source. 
 

Setup for Automatic Features 
 

5.8.1 Devices Settings 

 
Go to Device settings and setup for Refraction Shot, typically setup is 0.125 sample 

interval with short acquisition time.  Example shows 1 second record 
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5.8.2 Auto Save Menu 

 
Options- Preference- Auto Save Menu 
 
Allows data to be automatically saved to database or exported to SEG-Y or SEG-2 data.   
 
Example shows saving all data to database and SEG-Y files.  Large number of records in 

database can slow system.  The database storing can be unselected to speed up system with large 
number of records.   

 
Viewing and confirming before saving.  This function requires that all data be viewed 

before saving. 
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5.8.3 File Export Menu 

Options – Preference – File Export Menu 
 
This menu selects the naming option for the SEG-Y file names 
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5.8.4 Stack Menu 

 
Options – Preference- Stack menu 
 
This menu selects the options for the automatic stack function. 
 
Data stored in database can also be stacked at a later time to eliminate bad records.  To 

speed up field acquisition, it is sometimes desirable to save all records and stack and review data 
in the office. 

 
Example shows saving and exporting stacked records to database and SEG-Y files.  

Number of Hits at one location is set to 10.  This is normally set to a larger number than required 
to allow large number of automated hits at one location.  The Stacked Data will be viewed after 
every Hit, and if the stack looks OK, then the Stack can be saved early by pressing the “ESC” key 
to stop automatic functions, then the “F2” key to save and reset the stack. 
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5.8.5 Real Time Noise Window 

 
The Real Time Noise Window can be used to determine the best time to do a refraction 

hit.   Sometimes the Refraction study is done in an urban area with large ambient noise from 
airplanes, large trucks, etc.  This ambient noise should be at a minimum when Hammer Hits are 
taken. 

 
Select Noise Window and set the Noise Window for a Fixed Y Axis.    
Y Min = 0 and Y Max = 0.00004, Disable the Y Auto Scale.  (This will set maximum 

noise to 40 microvolts RMS some area may require different max scale.) 
 

 
 
After setting the Y-Scale, then set the Noise Analysis for “Real Time”.  The Bar graphs 

will continually update showing the noise level on all of the spread channels. 
 
 
The Hotkey “N” is used to toggle the Real Time Noise Monitor ON and OFF. 
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Typical Refraction Shot Screen Setup with Noise Monitor 
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5.8.6 Acquiring Refraction data with Hammer Hits 

 
Press “Ctrl R” to enable the “Repeat Start” or “Auto Start” function of the system 
 
Press “A” – Starts Auto Sequence 
 

Wait for Real Time Noise Monitor to show Low Noise – (Press “N” to enable the 
real time Noise Feature) 

 
Hit Strike Plate with Hammer 
 
System will display first “Hit” data 
 
If this record is OK, press “Y” to save it to database and add it to the stack 
 
Press “N’ to discard data 
 
Wait for Real Time Noise Monitor to show Low Noise 
 
Hit Strike Plate with Hammer 
 
System will display first “Hit” data 
 
If this record is OK, press “Y” to save it to database and add it to the stack 
 
Press “N’ to discard data 
 
The system will then display the stacked data 
 
Repeat Hit Sequence until Stacked data is OK 

 
To save stacked data before total number of Hits entered in stack menu 
 
Press “ESC” to Stop Acquisition 
 
Press “F2” to “Save Stack” and “Clear Stack Counter” 
 
After Saving Stack then Move to next Shot Point and repeat Hit Sequence 
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5.9 VScope “Hotkeys” 
The following “Hotkeys” can be used with the VScope Program.  These “Hotkeys” allow 

quick access to functions without having to use the mouse and the mouse buttons.  
 
“A” – Start Acquisition 
“ESC” – Stops Acquisition – also exits some menus 
“Ctrl S” – Save Data to database 
“Ctrl O” – Open Database Explorer to load record 
 
“Ctrl R” – Repeat Start – Auto Start On/Off 
 
 
 
 
Stack “Hot Keys” - used when Auto Stack selected 
 
“Esc” – Stops Acquisition 
“Ctrl L” – Clears Stack resets counter 
“Ctrl S” – Save Stack at anytime 
“F2” – Save and Start new Stack 
 
 
Confirm Save Menu 
 
“Y”, “Enter” – Save 
“N”, “Esc” – Do Not Save 
 
Confirm Stacking 
 
“Y”, “Enter” – Add to stack 
“N”, “Esc” – Do not add to stack 
 
Plots 
“Ctrl N” – new plot 
“Ctrl I” – invert plot On/Off 
“Ctrl D” – remove DC offset On/Off 
“Ctrl X” – Axis settings 
“Ctrl F” – Full view 
 
Real Time Noise Monitor 
 
“N” enables/disables Real Time Noise for the Noise Bar Graph 
 
Filters 
“Ctrl T” – High Cut On/Off 
“Ctrl Z” – Low Cut On/Off 
“Ctrl Y” – Notch On/Off 
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Seismic Plot 
“+” – Increase amplitude 
“-” – Decrease amplitude 
“*” – Stretch in time 
“/” – Compress in time 
“Home” – To the first trace 
“End” – To the last trace 
“PgUp”/”PgDn” – Move up and down  
Arrows – Move cursor 
Ctrl + Arrows – Scroll plot slowly 
Sift + Ctrl + Arrows – Scroll plot fast 
 
Roll 
“F4” – Roll Up 
“F3” – Roll Down 
“Ctrl F3’ – Roll to beginning 
“Ctrl F4” – Roll to end 
 
Other Hot Keys in main window 
 
'D' - Device 
'P' - Preferences 
'U' - Auto Save settings 
'S' - Stacking settings 
 
Most of the controls in any of these windows have short cut key which are underlined.  
It can be used with Alt and in most cases even without it. For example,  

press 'Q' to get to DAQ Settings in Device window. 
 
High Cut Filter is "Ctrl T” 
 
Real time RMS Noise is controlled with 'N' key.  
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5.10 Geophone and Line Test 
The DAQLINK 4 has a built in Geophone Test and Line test feature.  This test performs a 

“Pulse Test” on all of the geophones.  The results of the test are shown on a bar graph at the 
bottom of the Screen. 

 
Press F10 to open the Geophone Test bar graphs. 
 
Press F9 to start a new Geophone/Line Test 

 

 
 

 
 
 
The Bar Graph shows “Green” if all geophones are connected and are planted correctly.  

Move your mouse to any box on the “Bar Graph” and click it with the mouse and the Resistance, 
Frequency and Damping of the station will be shown. 

 
 
 
 
 
If the Geophone is on its side the Bar Graph will display “Yellow”.  Note: Higher 

Frequency Geophones (30Hz +) will show green when on their side. 
 

 
 

If the Geophone is not connected or the cable is “open circuit”, then the bar graph shows 
RED.  The Resistance is measured greater than 4000 ohms then the Graph shows RED  
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5.11 Triggering Multiple DAQLink 4s 
The DAQLINK 4 has various options for triggering. 

 

 
 

For Multiple DAQLink 4 triggering a special “Trigger On Time” feature is built in on all 
modes.  When one DAQLink 4 unit triggers a special “Trigger On Time” message is sent to all 
other DAQLink 4 units through the Ethernet Network.  This message is received by all of the 
other DAQLink 4 units and they will trigger and send data back to the main computer. 

 
The “Trigger on Time” feature requires a GPS receiver at every DAQLink 4 unit to 

synchronize the internal clock in the DAQLink 4.  The DAQLink 4 unit must receive at least 10 
valid PPS pulses from the GPS system to synchronize the internal clock.  After the internal clock 
has been synchronized, then GPS signal can be removed.  This allows operation in areas where 
the GPS coverage is intermittent.  If the internal clock has not been synchronized, then the 
“Trigger on Time” message is ignored. 

 
After receipt of the “Trigger on Time” message, all of the DAQLink 4 units will retrieve 

the appropriate data stored in the memory of the unit.  The exact time of the trigger event is used 
and the data from each DAQLink 4 is sent back to the central recording system. 

 
This special “Trigger on Time” feature allows multiple DAQLink 4 units to be used with 

only the Ethernet and GPS connected at each DAQLink 4. 
 
Very accurate triggering can be performed using Multiple DAQLink 4 units and wireless 

Ethernet systems.  
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5.12 Roll along Feature  
The DAQLINK 4/VScope has a built in Roll along feature.  This feature allows different 

channels to be enabled and the spread to “Roll” with the acquisition. 
 
Go to the Options- preference- Roll menu: 

 

 
 

Select the “Roll enable” to enable the Roll Feature 
 
Select the Total number of Active channels for each acquisition. 
 
Select the “Roll” increment.  This entry selects how many channels will be incremented. 
 
Auto roll can be enabled – either Roll up increment or Roll down decrement can be 

enabled. 
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When the Roll along feature is enabled, the Roll tool bar is shown in the main Windows 
Tool bar 

 
 
The Roll control buttons allow the spread to be rolled manually. 
 
The display in the middle shows the active channels. 
 
 
The following “hot keys” can be used to move the Active channels for the Roll feature. 
 
Roll 
“F4” – Roll Up 
“F3” – Roll Down 
“Ctrl F3’ – Roll to beginning 
“Ctrl F4” – Roll to end 
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6 Advanced Features 

6.1 DAQLink 4 Continuous Recording 
 
The DAQLink 4 has the ability to perform almost continuous recording.  Typical this 

type of recording is done using a GPS receiver.  This allows the recorded events to be referenced 
to a GPS time. 

6.1.1. VScope Auto Start Function 

The Auto Start function allows the DAQLink 4 to perform continuous recording.  There 
are two basic auto start features with the VScope and DAQLink 4 system.  The VScope auto start 
allows the software program to restart the DAQLink 4 unit.  The DAQLink 4 auto start allows the 
DAQLink 4 to auto start itself without being commanded from the VScope program. 

VScope auto start allows the VScope program to restart the DAQLink 4 unit.  This 
function is enabled by pressing the “Auto Start” button on the tool bar, or by pressing the (Ctrl + 
R) Hot Key.  This function toggles the auto start “on” and “off”.  After auto start is enabled, a 
manual start is required to start the cycle. 

When the VScope auto start is enabled, the VScope program first completes acquisition 
of the current record, and then automatically restarts the DAQLink 4 unit.  There will be a delay 
between records depending on the acquisition parameters. 
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6.1.2 DAQLink 4 Auto Start Feature 

The DAQLink 4 also has an auto start feature.  This feature is enabled in the Options-
Device-DAQ setting menu.  Advance Mode must be selected in the Option-Preference menu to 
enable this screen.  There are three selections in this menu: 

1. Disabled – This selection disables the DAQLink 4 auto start 
2. Without Start Command – When this selection is enabled, the DAQLink 4 will 

start acquisition as soon as the unit is powered up.  This selection is used when 
the DAQLink 4 will not be connected to a computer running VScope during 
acquisition. 

3. After Start Command – This selection enables the auto start feature after a 
“Start” Command has been sent from the VScope program.  This mode is used 
when the unit is connected to a computer running VScope. 
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6.1.3 GPS Trigger on PPS 

 
The DAQLink 4 unit can be set to trigger on the GPS PPS clock.  First the trigger on PPS 

pulse must be selected in the trigger selection, and then the Timer values must also be selected. 
 

Timer Value: 
 
Start At: The Start At time is used when the exact time of an event is to be used to 

trigger the DAQLink 4.  Example: 01:00:00 will delay the start of acquisition until 01:00 GMT.  
(This time is referenced to GPS time).  An entry of 00:00:00 is used to allow the repeat every 
entry to be used without an exact start time. 

 
Repeat Every:  The repeat every entry is used to determine when the next auto start will 

occur.  Example an entry of 00:10:00 will cause an auto start to occur the next time the GPS time 
is on an even 10 minute boundary (10:00). 

 
Example 1:  It is 1:13 GST.  The DAQLink 4 is set with the following: 
Start Time = 00:00:00 
Repeat Every = 00:10:00 
 
The DAQLink 4 will start acquisition at the following times: 
01:20 GST 
01:30 GST 
01:40 GST 
etc.. 
 
Example 2:  It is 1:13 GST.  The DAQLink 4 is set with the following: 
Start Time = 02:00:00 
Repeat Every = 00:10:00 
 
The DAQLink 4 will start acquisition at the following times: 
02:00 GST 
02:10 GST 
etc.. 
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6.1.4 DAQLink 4 Timing - GPS 

 
For standard continuous recording the GPS units are used to start the acquisition and to 

synchronize the DAQLink 4’s internal clock oscillators.  The DAQLink 4 unit must receive one 
valid position and a valid PPS pulse from the GPS unit to start using the trigger on PPS mode.  
After this first valid PPS, the internal clock of the DAQLink 4 units are used to trigger the later 
records.   

 
Whenever the recording time equals the value entered in the “repeat every entry”, then 

the DAQLink 4 will be in true Continuous recording mode with no GAPS.  The trigger must be 
set to either PPS or Auto trigger 
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6.1.5 Continuous Recording Examples 

 
Example 1:  Setup DAQLink 4 for Autonomous continuous recording using GPS time. 
 
With the following setup the DAQLink 4 will record the data to the internal Flash 

memory.  The data must be downloaded to the VScope computer after recording is completed.  
Each record will have 60 seconds.  There will be a NO delay between records.  

Sample Rate = 1.00 msec 
Sample Length = 60 seconds 
Standalone Mode enabled – this selection disables the output to the VScope computer. 

 

 
 

Trigger on PPS pulse 
Start Time 00:00:00 
Repeat Every 00:10:00 
Synchronize A-D 
Auto Start – Without Start command 
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The internal GPS oscillator should also be adjusted to GPS time.  This allows for the long 
records to have correct timing. This selection is found in the Device- Options-Advanced settings 
tab. 
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6.2 Continuous Monitoring of data 
The VScope DAQLink 4 system allows continuous monitoring of a small number of 

channels.  Larger number of channels slows the computer program system too much for 
continuous monitoring.  First set up the DAQLink 4 for short records. 

Example 1 msec sample rate 
1 second record 

 

 
 

Set up the DAQLink 4 to record.  Configure the system for appropriate trigger method. 
Either set up for auto trigger (for continuous monitoring) or use actual trigger (to record an actual 
event). 

Select signal graph and go to axis setup. 
Select Scope Mode, and set x –axis to larger than acquisition time. 
Start acquisition.  Each time the 1 second record is received; the graph is updated in real 

time.  Example shows result of 6 one-second records. 
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6.3 DAQLink 4 Flash Card Download 
The DAQLink 4 unit stores all data to an internal compact Flash card.  The records can 

be downloaded to the VScope program after data has been acquired. 
 
Before using the Flash Card option, it is best to reset memory in the Flash Card. 

 

 
 

Reset Memory – pressing this button will cause the next record to be recorded at the first 
of the memory card. 

Erase Memory – This function erases all data from the Flash card.  This is not usually 
required.  It may take over an hour to erase all memory from a Large Flash Card. 
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6.3.1 Downloading single records 

To download a single record from the DAQLink 4 Flash card memory, go to Options-
Download Menu. 

After pressing the “Get List of Records” button, a list of all of the stored data will appear. 
 

 
 

Select record to be downloaded from the list by highlighting the record.  Press Download 
selected. 

Record will be downloaded.   
Press Close to view the record. 
Press File – Save to save the record. 
 



 

DAQLink 4 User Manual 

Seismic Source Company 113 

6.3.2 Downloading Multiple Records 

 
To download a multiple record from the DAQLink 4 Flash card memory, go to File – 

Open Menu, and open the database explorer. 
From the database explorer, go to the DAQ- Download Records menu. 

 
 
There is also an option to download all of the data stored in the Compact flash. 
 
After pressing the “Get List of Records” button, a list of all of the stored data will appear.   

 
Select the records to be downloaded from the list by highlighting the record.  Press 

Download selected. 
The selected records will be stored to the database. 
 
If the Time of the record matches another Time already in the database then the new 

record will be added to the existing record.  This allows data from multiple DAQLink 4 units to 
be combined together in the database. 

 
To prevent combining of records press the “ctrl” button when the Download is selected. 
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6.3.3 Compact Flash Card Operation 

 
The DAQLink 4 larger Compact Flash (CF) cards have 1 to 3 % bad sectors.   These bad 

sectors are identified when the card is formatted, and these sectors are mark. 
 
It is important that the CF Card be formatted when installing new CF cards or moving a 

CF card from one DAQLink 4 to another unit. 
 
Go to the Device – DAQ Settings – Advance Menu and select “ERASE Memory” 
 
 
Erase Memory button is used to FORMAT the CF Card.  This process should take only a 

few seconds.  The Status LED will FLASH RED while formatting.  IF the Status LED continues 
to FLASH RED, then the CF Card must be replaced. 
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6.3.4 Compact Flash Storage 

 

The compact flash card stores all recorded data.  Different size Compact Flash cards are 
available.  The cards must have a very fast read and write time to be able to record at the fast 
sample rates. 

The number of records that can be stored depends on the sample rate, number of 
channels, and record length. 

When the memory is full, the DAQLink 4 starts over at the beginning and overwrites the 
stored data at the beginning of the Flash Card memory. 

 
To estimate number of records, the following guidelines can be used. 

 
 Each sample of data = 3 bytes  
 Header information = about 12% of record length (normally ignored when 

estimating).  Each record requires additional bytes depending on GPS time and other 
peripheral information being recorded 

 
Example 1: 24 channels at 2msec, 1 second record.   
24 channels * 500 samples/sec* 1second* 3 bytes/sample  
Equals = 36 K bytes 
Or a 32 Megabyte Compact Flash can hold about 800 records 
A 1 Gigabyte Compact Flash Card can hold about 27,000 records 
 
. 
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Example 2:   
 
Sample Rate = 1/16 msec 
Record Length = 1 second 
Number of channels = 2 
 
Number of bytes/ record 

 = (16,000 SAMPLES/SEC) * (3 BYTES/SAMPLE) * 24 CHANNELS  
= 1,152,000 BYTES/SEC 

 
Theoretical Maximum Storage: 

2GB should hold 1736 one-second records 
8GB should hold 6944 one-second records 

 
Actual Storage results 
 
2 GB recorded 1538 records in list (0.886 of the 1736) 
 
 
8 GB recorded 6091 records in list (0.877 of the 6944)  
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6.3.5 Speed of Downloading 

 
A large CF card will take a long time to download data to the database. 
 
Example: 24 channels at 1/16 msec sample rate with 1 second record 
 
100 records   82 seconds 
1.30 hours for 8GB  
 
 
Downloading Data from CF card 
 

1) First go to the Database Explorer ( File – Open menu) 
2) Go to the DAQ – Download Records menu 
3) Select “DAQ Link Unit”  number to download 
4) Press “Get List of Records” 
5) Wait for list to be completed 
6) Select from the list the Records to download 
7) “Ctrl A” is used to select all 
8) After Selecting records – Press Download Selected 
9) Wait for Download to be completed 
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6.4 Changing data in Database 
The data in the database can be change by editing the values in the DAQLink 4 settings.  
 

6.4.1 Changing Trace Order 

 
First open the file with the database explorer.   
 
Click on DAQ Config and Channel Config buttons to make the list of channels visible. 

Click on the channel to be shifted and press F7 or F8 to move it up or down the list. 
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6.4.2 Changing Polarity of a trace 

 
First open the file with the database explorer.   
 
Click on DAQ Config and Channel Config buttons to make the list of channels visible.  
 
Click on the Calibration value of the trace to be inverted.  Click on the Minus sign to 

invert the polarity. 
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Test signals can be connected to the analog section of the DAQLink 4 unit by selecting 
“Loopback” in the DAQLink 4 configuration - Input selection.  When “Loopback” is selected, the 
“Geophone Input” is not connected to the circuit and the analog input is connected only to the 
analog circuit of the DAQLink 4. 

 
When the input is selected to “normal” both the input geophones and the DAQLink 4 

Analog circuit is connected to the Analog Output.  
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6.6 Viewing detail of record 
The details of the seismic record can be viewed by pressing “ctrl –alt –D” 
 
This screen is used for development of the program and should not be used by novice 

operators of the system.  However, this screen may be useful in troubleshooting problems. 
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7.1 Computer Network Setup 

7.1.1 Introduction 

Normally, it is necessary to set up a fixed TCP/IP address for the computer to 
communicate with the DAQLink 4 unit. 

 
IP Address SET to FIXED IP ADDRESS – 10.0.0.101 

 
All Firewalls Disabled 
 

7.1.1.1 Pre-Requisite Software 
 Run full installer to get all pre-requisites installed. Latest full install of SSC/iSeis 

applications is located at http://files.seismicsource.com/Software/SSC_setup.exe 

7.1.1.2 Ethernet Setup 
 For DAQ4 and Sigma use 10.X.X.X with 255.0.0.0 subnet static IP 
 For DAQ3-24 use 192.168.0.X with 255.255.255.0 subnet static IP 
 For HyMesh contact SSC/iSeis 

7.1.1.3 Notes 
Before communicating with most Seismic Source and iSeis equipment, a FIXED IP 

ADDRESS must be set in the computer, and the WinPcap Ethernet driver must be loaded.  
To set up a fixed TCP/IP address for your computer perform the following: 

 IP Address SET to FIXED IP ADDRESS: 10.0.0.101 
 Subnet MASK: 255.0.0.0 
 It is also recommended to disable all other Network connections. 
 All Firewalls Disabled 
 Computer Control of Network Card Power Disabled 

It is sometimes necessary to reboot the computer to have the new address take 
effect. 
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7.1.2 Windows 10 Ethernet Setup 

Windows 10 is the newest of the Microsoft operating systems, and many of the 
menus have changed.  And several of the screens may be different depending on the 
updates applied to the computer. 

Make sure the Computer IP address is on 10.x.x.x network (e.g. 10.0.0.101) with all 
firewalls and power management disabled. 

If computer has not been setup for this IP address: 

7.1.2.1 Changing the Computer’s IP Address 
For Windows 10, right-click on the Microsoft Window’s logo in the bottom left 

corner of the screen.  Then select the “Network Connections” option. 

 
Right-Click Menu showing Command Options 

 
These options can also be found in the Windows 10 “Control Panel”. 
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The “Network Connections” window will display all the available network options 
on the computer.  Next, right-click on the Ethernet adapter for the cabled connection, 
and then on the “Properties” option for the adapter. 

 
Pop-Up Menu showing available Network Adapters 

 
It is also recommended to disable other network connections that might conflict 

with the communication process.  Highlight the other connections (like Wireless) and 
select Disable. 
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In the Properties menu for that adapter, select “Internet Protocol Version 4 
(IPv4)”, and then click on the “Properties” button. 

 
Control Panel showing Network and Sharing Center 

 
Also, consider disabling (by un-checking the selection box) the “Internet Protocol 

Version 6 (IPv6)” option. 
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Updating the “IP address” and “Subnet mask” 

 
 
Use following address and mask: 

 IP address ....................... 10.0.0.101 
 Subnet Mask .................. 225.0.0.0 

Press OK to accept entries. 
 
It is sometimes necessary to reboot the computer to have the new address take 

effect. 
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7.1.2.2 Changing the Computer’s Firewall Setting 
For Windows 10, right-click on the Microsoft Window’s logo in the bottom left 

corner of the screen.  Then select the “Network Connections” option. 

 
Right-Click Menu showing Command Options 

 
These options can also be found in the Windows 10 “Control Panel”. 
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7.1.2.3 Changing Window Defender’s Setting 
For Windows 10, right-click on the Microsoft Window’s logo in the bottom left 

corner of the screen.  Then select the “Network Connections” option. 

 
Right-Click Menu showing Command Options 

 
These options can also be found in the Windows 10 “Control Panel”. 
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DAQLink 4 User Manual 

Seismic Source Company 135 
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7.1.2.4 Changing Network Adaptor Power Managment 
For Windows 10, right-click on the Microsoft Window’s logo in the bottom left 

corner of the screen.  Then select the “Network Connections” option. 

 
Right-Click Menu showing Command Options 

 
These options can also be found in the Windows 10 “Control Panel”. 
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The “Network Connections” window will display all the available network options 
on the computer.  Next, right-click on the Ethernet adapter for the cabled connection, 
and then on the “Properties” option for the adapter. 

 
Pop-Up Menu showing available Network Adapters 

 
It is also recommended to disable other network connections that might conflict 

with the communication process.  Highlight the other connections (like Wireless) and 
select Disable. 
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In the Properties menu for that adapter, select “Internet Protocol Version 4 
(IPv4)”, and then click on the “Properties” button. 

 
Control Panel showing Network and Sharing Center 

 
Also, consider disabling (by un-checking the selection box) the “Internet Protocol 

Version 6 (IPv6)” option. 
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7.1.3 Windows 8 Ethernet Setup 

Windows 8 is the most flexible of the Microsoft operating systems, so the screens 
may be different depending on the updates applied to the computer. 

Make sure the Computer IP address is on 10.x.x.x network (eg.10.0.0.99 or 
10.0.0.101) with all firewalls and power management disabled. 

If computer has not been setup for this IP address: 

7.1.3.1 Changing the Computer’s IP Address 
For Windows 8: Use a right-handed sweeping motion from the right side of the 

screen towards the left with a single finger, and select “Control Panel”. 

 
Charm Bar showing Control Panel Option 
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Also for Windows 8.1: Or right-click on the semi-Windows logo in the bottom left 
corner.  From the pop-up menu select “Control Panel”. 

 
Pop-Up menu showing Control Panel Option 

From the Control Panel, select “Network and Sharing Center”. 

 
Control Panel showing Network and Sharing Center 

It is also recommended to disable all other Network Connections.  Highlight the 
other Network Connections (like Wireless) select Disable. 
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From the Network and Sharing Center select “Change adapter settings”. 

 
Network and Sharing Center showing installed Networks 

From the Network Connections select network connected the Sigma Device.  This 
is quite possibly the network labeled as “Unidentified network”. 

 
Selecting the “Wired” Network 
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Set the Properties for the “Unidentified network”. 

 
Click on Properties 

It is also recommended to disable all other Network Connections.  Highlight the 
other Network Connections (like Wi-Fi) and select Disable. 

Set the Properties for the “Internet Protocol Version 4 (TCP/IPv4)”. 

 
Set the TCP/IPv4 addresses 
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Set the IP address and the Subnet mask. 

 
Use following IP -> IP address: 10.0.0.99, Subnet Mask: 255.0.0.0 

 
It is sometimes necessary to reboot the computer to have the new address take 

effect. 
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7.1.3.2 Modifying the Computer Firewall Options 
To communicate with a Sigma Unit, either disable the firewall for that network or 

else set the permission for the Sigma Software. 
From the Control Panel, select the “Window Firewall” option. 

 
Selecting the “Windows Firewall” option 

 
In the “Window Firewall” menu, select the “Allow an app or feature through 

Windows Firewall” option. 

 
Selecting the Windows Firewall pass-through menu 
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Once in the menu, click on the “Change settings” option. 

 
Selecting the “Change settings” option 

Also, the settings for an individual program can be adjusted. 

 
Inspecting options for a program or app 

 
It is sometimes necessary to reboot the computer to have the new address take 

effect.   
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7.1.4 Windows 7 Ethernet Setup 

Make sure the Computer IP address is on 10.x.x.x network (eg.10.0.0.99 or 
10.0.0.101) with all firewalls and power management disabled. 

If computer has not been setup for this IP address: 

7.1.4.1 Changing the Computer’s IP Address 
For Windows 7: Go to Start->Control Panel->Network and Internet->View 

Network Status and tasks->Change adapter settings->Local Area Network 

 
Right click and select Properties 

 

It is also recommended to disable all other Network Connections.  Highlight the 
other Network Connections (like Wireless) select Disable. 
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Select Internet Protocol Version 4 -> Properties and set 

 

 
Use following IP -> IP address: 10.0.0.99, Subnet Mask: 255.0.0.0 
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7.1.4.2 Disabling the Computer Firewall 
To program the TDMA, all firewalls needs to be turned off. 
Start->Control Panel-> System and Security->Windows Firewall and turn it off. 

This is very important as the firewall will block the communication. 
 
It is sometimes necessary to reboot the computer to have the new address take 

effect.   
 
If the UE2 unit was previously communicating with a computer with a different 

address, then the UE2 unit must be reset (power off then on) for the unit to 
communicate to the new address. 
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7.1.5 Vista, XP, and 2000 Support 

If circumstances require use of one of these older and discontinued operating 
systems, please contact us as we will always help. 
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7.1.6 TCP/IP Verification 

To verify that the IP address is correct, select “Start”, then “Run”, then type in 
“CMD”.  This starts the command prompt in Windows (This is similar to the old DOS 
command prompt).  Type the command “ipconfig”.  The current IP address 10.0.0.101 
should be shown. 

 

 
Viewing the IP configuration in a Command window 

 
 
 
Viewing the Network Tab at the bottom of the Vscope program can also check 

the IP address.  The Network Tab shows the current IP address detected by the Vscope 
program. 

 

 
Viewing IP address in Vscope 
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8 Specifications and Options 

8.1 Options 
 
The DAQLink 4 unit has several options 

 CF Card – 8 GB standard (upgradable to 32 or 64 GB).  The Flash card is used 
for: 

o Buffering of data - Temporary storage of data until data can be sent over 
network.  Amount of storage required depends on the speed of 
acquisition and the speed of the network 

o Storage of data while not connected to network.  The Flash card can be 
used to store data while the unit is not connected to the network, later 
this data can be downloaded to the computer. 

 GPS option – The GPS option is used for  
o Position information – When valid position data is available from the 

GPS receiver the position information is stored along with the data. 
o Timing – The GPS receiver can be used to stored precise time of the data 

collection 
o Oscillator adjustment- the internal oscillator of the DAQLink 4 unit can 

be adjusted to match the GPS clock. 
 Analog Cables 

o The DAQLink 4 unit has a 55 pin connector for the analog inputs.  
Various analog cable options are available for the end user. 

 Power and Ethernet Switch Box  
o This option allows multiple boxes to be connected over the Ethernet 

cable 
o This option can also be used between boxes to increase the maximum 

distance between boxes.  The standard specification for transmission of 
data over CAT5 cable is 100 meters. 

 Distributed DAQLink 4 unit – allows multiple boxes to be connected at a 
distance of over 5000 feet with standard phone line. 

 Wireless Ethernet Option 
o Wireless Work group bridges and Wireless access points can be used to 

transmit the data from the DAQLink 4 unit to the host computer 
o High Gain antenna are available to increase the range of the Wireless 

network 
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8.2 DAQLink 4 Specifications 
1 to 24 channels per unit 
Weatherproof enclosure 
Multiple units can be used together 
 for large channel count 

A/D conversion:  
24 bit high-speed sigma delta converters 

Dynamic range:  
144 dB (system)  
Greater than 125 dB (measured at 2msec) 

Bandwidth:  
DC to 20 KHz – 
Digital Filter Bandwidth = 85% of (sample rate)  

Common Mode Rejection:  
Greater than 100 dB 

Crosstalk:  
Better than 125 dB 

Noise Floor:  
0.15 microvolt RMS noise (2 msec sample rate) 

Trigger Accuracy:  
+/- 1 microsecond at all sample rates 

Maximum Input Signal:  
X 1 gain: 6.6 volts peak to peak 
X 4 gain: 1.65 volts peak to peak 
X 16 gain: 0.412 volts peak to peak 
 

Input Impedance:  
100 K ohms 

Preamplifier Gains:  
X1,X4 and X16 standard; software selectable 

Anti-alias Filters:  
85 % of Nyquist frequency 

Digital Filters: 
Low Cut – User Selectable frequency 
Notch – 50 or 60 Hz standard – User selectable 
High Cut – User Selectable 

Sample Interval:  
0.0156,.0.0208, 0.0625, 0.125, 0.250, 0.500, 1.00, 2.00, 4.00, 8.00 millisecond 

Sample Frequency:  
64000, 48000, 16000, 8000, 4000, 2000, 1000, 500, 250, 125 samples/second 

Record Length:  
Up to 16 Gbytes/ number of channels  

Pre- trigger delay:  
10 second 

Continuous Recording Option 
GPS Interface Standard 
 Internal Clock synchronized to GPS time 
 GPS Time and Position saved with data 
Internal Storage: 

Compact Flash style storage media    
Standard FAT16 or FAT32 file system 
(Maximum file size = 32GB) 

100Mbit Ethernet  
Download speed 8MByte/sec; real time transfer 

Power consumption:  
                24 channels – less than 0.14 watts/channel 
Built in Line Testing and Instrument Tests 
 
Size: 380x250x40 mm 
Weight: 2.0 Kg  
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9 Schematics 

9.1 DAQLink 4 Connector wiring 
DAQ4 
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Distributed DAQlink4 
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9.1.1 Ten pin Ethernet Connector  

H….. TD+ 
A….. TD- 
B…..RD+ 
F…..RD- 
J….. +12 volts 
K….Ground 
 

9.1.2 2-pin Power Connector 

A.......... Positive Battery 
B .......... Negative Battery 

 
There are two internal fuses on the board to prevent damage to the unit.  However, SSC 

recommends using external 2 amp fast blow fuses to protect the DAQLink 4.  The unit can be 
powered from any DC source supplying a minimum of 11 to a maximum of 18 VDC. 

 

9.1.3 3-pin Trigger Connector 

A.......... TB active 
B .......... TB return (ground) 
C .......... +12 volt through 5 kOhms resistor 

 
When DAQLink 4 trigger option is set to trigger on Time Break, then this input is used to 

trigger the box.  This input drives an op-amp input and the trigger level is set by software.  
Normal trigger level is 2 volts minimum to trigger.  Positive Voltage should be applied to pin A, 
and negative voltage to pin B.  Maximum voltage should be less than 60 volts. 

When using standard “Hammer Switch”, connect Pin A to Pin C and to the High voltage 
side of the ST-01 switch.  Connect pin B to the Low voltage side of the ST-01 switch. 
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9.1.4 6-pin GPS Connector 

A.......... Battery +12 volts (supplies power to GPS receiver) 
B .......... GPS RX (receives GPS data from GPS receiver) 
C .......... GPS PPS 
D.......... Ground 
E……..GPS TX 
F……..Ground 

 
An external GPS receiver can be connected to the 19 pin GPS connector using a PT06A-

14-19P.  The GPS receiver must be setup for RS232 voltage levels 
 19200 baud 
 $GPGGA and $GPRMC messages only 
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9.1.6 19-pin USB Connector 

C .......... +5 volts 
E .......... USB_DM 
F……..USB_DP 
H…….Ground 

9.1.6 14-pin Misc. Connector 

A.......... SPKR+ 
B .......... SPKR - 
C .......... MIC A 
D.......... RADIO RTN 
E .......... PTT A 
F .......... Geophone + - AUX Trigger input + 
H.......... Geophone - - AUX Trigger Input - 
J ........... +3 volts 
K.......... external LED GREEN - Battery 
L .......... external LED RED - Battery 
M ......... external LED GREEN Status 
P .......... external LED RED Status 
R .......... external LED Network LINK  
S .......... external LED Network ACTIVE 
 

9.1.7 55-pin Analog Data Connector 

Pin .............. Signal  Pin ..............Signal 
A ................ Ch 1 pos  b .................Ch 13 pos 
B ................ Ch 1 neg  c .................Ch 13 neg 
C ................ Ch 2 pos  d .................Ch 14 pos 
D ................ Ch 2 neg  e .................Ch 14 neg 
E ................ Ch 3 pos  f ..................Ch 15 pos 
F ................. Ch 3 neg  g .................Ch 15 neg 
G ................ Ch 4 pos  h .................Ch 16 pos 
H ................ Ch 4 neg  i ..................Ch 16 neg 
J ................. Ch 5 pos  j ..................Ch 17 pos 
K ................ Ch 5 neg  k .................Ch 17 neg 
L ................ Ch 6 pos  m ................Ch 18 pos 
M ............... Ch 6 neg  n .................Ch 18 neg 
N ................ Ch 7 pos  p .................Ch 19 pos 
P ................. Ch 7 neg  q .................Ch 19 neg 
R ................ Ch 8 pos  r ..................Ch 20 pos 
S ................. Ch 8 neg  s..................Ch 20 neg 
T ................ Ch 9 pos  t ..................Ch 21 pos 
U ................ Ch 9 neg  u .................Ch 21 neg 
V ................ Ch 10 pos  v .................Ch 22 pos 
W ............... Ch 10 neg  w ................Ch 22 neg 
X ................ Ch 11 pos  x .................Ch 23 pos 
Y ................ Ch 11 neg  y .................Ch 23 neg 
Z ................ Ch 12 pos  z .................Ch 24 pos 
a ................. Ch 12 neg  AA .............Ch 24 neg 
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9.1.8 Cable connectors Part Numbers 

 
The following part numbers can be used to purchase cable connectors for the DAQLink4 

unit: 
 

Ethernet Plug………………851-06AC12-10P50…….PT06-12-10P 
USB Plug ............................ 851-06AC14-19P50…….PT06-14-19P 
MISC/Aux trigger………….851-06AC12-14P50…….PT06-12-14P 
Analog Channel Plug .......... 851-06A22-55S50……....PT06-22-55S  
GPS Plug ............................. 851-06AC10-6P50………PT06-10-6P 
Power Plug .......................... 851-06AC8-2S50………..PT06-8-2S 
Trigger Plug ........................ 851-06AC8-3P50………..PT06-8-3P 
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9.2 DAQLink 4 Schematics 
 

9.2.1 Ethernet Wiring 
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9.2.1.1 Ethernet Cable 
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9.2.1.2 Ethernet Cable with POE for WiFi 

WIFI ONLY -DO NOT USE WITH COMPUTER 
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9.2.2 Trigger Wiring 
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9.2.3 GPS Internal Wiring 
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9.2.3.1 External GPS Wiring 

 
 

 
 
Schematic shows External GPS wiring for a 48 channel DAQlink system. 
 
A single GPS receiver can be used for two DAQlink units. 
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9.2.4 USB Wiring 
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9.2.5 Misc Connector Wiring 
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9.2.5.1 Aux Trigger Cable 
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9.2.6 Trigger Input Circuit 
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9.3 Distributed DAQLink4  

 
  



 

DAQLink 4 User Manual 

Seismic Source Company 172 

9.3.1 Distributed DAQLink Wiring 
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